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INTRODUCTION
This manual sets out the procedures to be followed when 
conducting presence/absence fauna surveys with camera traps 
under the auspices of the Moorabool Landcare Network (MLN). 

It covers:

 • The operation of camera traps provided by the MLN

 •  The deployment of camera traps and baits under  
various circumstances

 • Data management

 • Processing of photos and recording sightings

 • Consideration of OH&S issues

 • Animal welfare

This manual should preferably be used in conjunction with a 
hands-on training course. The outcome should be that you 
become familiar with the operation and deployment of camera 
traps for recording fauna and comfortable with the necessary 
data recording and processing to provide an accurate record of 
the sightings made.

One overlying principle should be kept in mind when conducting 
camera trap surveys.

The wellbeing of the animal and its habitat  
has a higher priority than the photograph.
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PERMITS AND APPROVALS
Permits
Any person undertaking fauna surveys using camera traps with baited lures in Victoria must apply for a Wildlife Research Permit 
from DELWP, even for surveys undertaken on private land. This will also require approval from the Wildlife and Small Institutions 
Animal Ethics Committee. If conducting surveys in a designated park, a Scientific Permit to Conduct Research may be required. 
Check the status of land managed under the National Parks Act 1975 on the DELWP site.

The camera survey program organised by the MLN is conducted under a Wildlife Research Permit from DELWP, along with animal 
ethics approval from the Wildlife and Small Institutions Animal Ethics Committee. Survey organisation must be carried out with the 
knowledge and under the control of the persons listed on the permit (Appendix I).

Survey organisers are responsible for ensuring that survey programs are carried out in accordance with the conditions on the 
permit and this manual. Tasks may be delegated by the survey organiser to other members of the network, but the organiser is 
responsible for ensuring that they are done and done correctly.

Approvals and OH&S
Camera trap surveys will be conducted across a range of land types, public and private. Before planning or undertaking any survey, 
ensure that permission of the land owner or manager has been sought and given. In locations with indigenous custodians, it is 
common courtesy to seek permission and ensure you are aware of any cultural sensitivities regarding your activities and target 
animals.

Any conditions requested by the land manager in terms of access or safe working procedures must be adhered to.

Any person taking part in the surveys with an allergy to peanuts must not be allowed to handle baits or bait holders.

Ethics and animal welfare
Camera trapping should not be undertaken if it results in altered behaviour, physical damage, stress, increased risk of predation or 
threatens reproductive success. 

White flash cameras should only be used when there is a definite need to obtain colour pictures to aid in animal identification. Site 
selection for white flash cameras should be carefully considered, as animals may avoid sites due to flash disturbance, which may 
have significant impacts on their welfare.

Survey planning
Besides land manager approvals, there are several things to do before taking the cameras into the field, which will increase the 
chance of success and minimise any impacts of the survey.

Knowledge is key
It is most important that you have a reasonable knowledge of target species and their habitat before deploying cameras in the field. 
For uncommon or endangered animals this knowledge needs to be extensive. Knowledge of an animal’s normal behaviour and 
habits will increase your chances of successfully capturing an image as well as minimising any risk to the animal from your activities. 
Having an understanding of what they eat (nectar, fruit, seeds, insects, eggs, meat, carrion, fungi etc), where they forage (trees or 
ground, dense bush or open areas), when they are active (dusk, dawn, day, night, phase of moon etc) and where they might travel 
or congregate (game trails, rub trees, water sources, carcases) improves your chances of success.

Previously recorded sightings of fauna of interest can be found via the Atlas of Living Australia and the Victorian Biodiversity Atlas.

Using the ALA database, fauna lists can be prepared for specific regions (state, council area, biogeographic region etc). Alternatively, 
a smaller region can be marked on an interactive map to obtain a record of sightings within that area. Information about specific 
fauna is also available.



6

Other sources of information can be Field Naturalist Club newsletters and historical newspaper reports.

BAIT CHOICE
The aim of using a bait or lure is to attract animals into the camera’s field of view for a brief period only. Animals should not be 
able to access the bait and feed on it. Providing a food source for the animal may change their behaviour and also runs the risk of 
introducing diseases to the population.

Using specialised baits and scent lures can improve your chances of detecting specific target animals. The range of bait mixes 
reported for fauna surveys is almost inspiring enough for a “cookbook”. Besides the usual mix of peanut butter, oats and honey (or 
golden syrup), people have used fish oil, sardines, chicken, dog food, strawberry essence, truffle oil, vanilla, pistachio oil, Chanel No 
5 and aniseed. Any bait or lure used must not cause harm to any animal if it is ingested.

Animal carcases may be used as an attractant, but only naturally occurring carcases from the area where the camera is to be 
deployed.

The use of recorded sounds (territorial, distress or breeding calls), stuffed or live animals as baits of any kind is not acceptable.

Species information page 
from the Atlas of Living 
Australia.
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LOCATION PLANNING
Whenever possible, cameras should be deployed so that they are out of the general public’s view and not likely to capture photos 
or videos of people. Locations should be selected allowing for reasonable access while carrying the equipment required.

For long term deployments with frequent site access, approaches to the site should be varied. It is important to minimise the 
chance of creating a track or scent trail to the site. Not only does this encourage other people, but human scent may attract feral 
animals such as cats and foxes.

Follow the principles of the Leave No Trace Center for Outdoor Ethics (https://lnt.org/learn/7-principles).

• Plan ahead and prepare

• Travel and camp on durable surfaces

• Dispose of waste properly

• Leave what you find

• Minimize campfire impacts (if camping)

• Respect wildlife

• Be considerate of other visitors

Equipment
Below is a list of equipment and supplies that will be required to conduct camera trap surveys.

• Motion sensitive camera with infrared flash

• Bait holders and bait

• Plastic bags (for holding baits and bait holders)

• Fluorescent marking tape

• Mobile phone

• GPS

• Compass

CAMERA LAYOUT
The layout of a typical camera is shown. Cameras are typically weatherproof but should not be submerged.

Reconyx Hyperfire camera 
exterior view.

https://lnt.org/learn/7-principles


8

PRINCIPLE OF OPERATION
When a camera trap is set up on site, it passively detects motion of fauna by detecting differences in surface temperature of objects 
in the detection zone. Hence, knowledge of the camera’s detection zone coverage is important to ensure correct aiming of the 
camera. When motion is detected, the camera is triggered to take a photo or video. Some cameras can be set up to take a photo 
then commence video recording.

If the light levels are low, an infrared filter is moved in front of the camera lens and the infrared flash is used to illuminate the area. 
Photos and videos are stored on an internal SD card of varying capacity. Photo file sizes can vary from 300kb to several megabytes, 
so SD cards have to be selected to ensure sufficient capacity to store all possible photos before the batteries are discharged. 

Although infrared light is supposed to be beyond the range of human sight, some animals can see further into the infrared range 
than we can. Some infrared flashes also produce a small portion of visible light, perceived as a dim red glow. Moving filters and 
electronic noise from camera circuitry also produces perceptible noise. Research has shown that camera traps produce sounds that 
are well within the perceptive range of most mammals’ hearing and produce illumination that can be seen by many species (Meek 
PD, et al. (2014) Camera Traps Can Be Heard and Seen by Animals. PLoS ONE 9(10): e110832.)

Reconyx 
Hyperfire camera 
interior view.
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DEFINITIONS
The following terms are used to define camera parts or operation.

 •  Light meter 
Measures the level of ambient light to determine if day or night (IR) mode is used.

 •  PIR detector

    Passive Infra Red sensor, which detects objects with a different surface temperature to the background. PIR sensors detect the 
surface temperature of objects in the detection zone and trigger the camera when a rapid change in temperature is detected. 
Note: the object does not need to be warmer than the background, merely a different temperature. It also does not need to 
be moving; having a different temperature object in the detection zone (e.g. a rock in the sun or shadows cooling an area) 
can trigger the sensor.

 • Field of view

   The angle of view in front of the camera which is seen on photos or videos. Typically about 50o, equivalent to a 30-35mm 
camera lens. Detection zones can sometimes be wider than the camera field of view.

 •  Trigger speed

   The time between the detection of an object by the PIR detector and the taking of a photo or video. Ranges from 0.2 sec to 
1.5-2 sec.

 • Delay or recovery time

   Time between individual photos if more than one photo taken per trigger event. Can also be set in camera settings to have a 
defined period before the next trigger event can take a photo or video. Used to avoid excessive triggering of the camera by 
animals lingering in the detection zone. 

 • Detector or PIR sensitivity

   The sensitivity of the PIR sensor can be set in most camera menu settings, usually Low, Medium  (Normal) or High. High 
settings will be more likely to trigger with animal movement but also give more false positives due to shadows, moving 
vegetation etc.

 • Time lapse

   Mode available in some cameras where photos or videos are taken at set intervals, without the need for a motion sensing 
event. Useful for monitoring large areas outside the detection zone.

 • Activation time

   Mode available in some cameras to only allow camera operation during a set period (e.g. only at night)

 • Walk test

   Mode available in some cameras and used for checking camera aiming and operation. When the camera is set up on site and 
in walk test mode, you can move in front of the camera in your desired detection area and a sensor light will display if the 
camera is triggered.



10

 • Fresnel lens 
  A lens consisting of a series of circular ridges designed to concentrate light from a large area onto the PIR sensor.

   Fresnel lens variation in camera traps. Multi-zone Fresnel lenses in (A) Reconyx PC90, (B) Reconyx PC900 and (C) Scout Guard 
SG550v models, and a single-zone Fresnel lens from a (D) Tevion WK1 camera trap. Each cell in the multi-zone Fresnel lenses 
represents a detection window. From Welbourne et al: How do passive infrared triggered camera traps operate and why does 
it matter? Breaking down common misconceptions; Remote Sensing in Ecology and Conservation Vol 2 p 77-83 (2016)

 • Detection zone
   The areas in front of the camera where animal movement can trigger the camera. It can vary widely between camera models 

due to the design of the Fresnel lens.

Reconyx Hyperfire detection zone. ScoutGuard Zero Glow 8M detection zone.

Camera field of view (yellow) is 50o.
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   Example of a detection zone shown in both the (A) plan and (B) lateral view. This type of array is representative of the 
ScoutGuard Fresnel lens shown previously that has six detection windows at the top and two detection windows at the 
bottom of the lens. From Welbourne et al: How do passive infrared triggered camera traps operate and why does it matter? 
Breaking down common misconceptions; Remote Sensing in Ecology and Conservation Vol 2 p 77-83 (2016)

PROGRAMMING THE CAMERA
Whatever camera you use, setting the right options can determine success or failure. Depending on the camera, you can set 
options for:

 • PIR sensitivity

 • Photo or video

 • Picture quality (MP or video resolution)

 • Number of pictures per trigger

 • Length of video

 • Delay between triggers

 • Flash range (some are automatic)

 • Time of operation

 • Time lapse mode

 • Date/time and other information stamps

For a full explanation of camera operation, refer to the appropriate manual. Cameras should be pre-programmed by the survey 
organiser with the appropriate settings for the surveys being conducted.

Settings can be changed for special circumstances but this should be discussed with an experienced operator to ensure correct 
operation. 

Camera settings should be recorded for each deployment and any changes from standard noted.
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BAITS AND BAIT HOLDERS
The customary choice of bait for attracting small mammals has been a mixture of peanut butter, oats and honey. However, the use 
of honey in baits is discouraged in areas where bee-keeping is conducted due to the risk of transmitting bee diseases. A typical bait 
recipe would be a mixture of:

 • Oats 2 cups

 • Peanut butter 1 cup

 • Golden syrup or treacle ½ cup

This bait mixture can be frozen until required for use. Depending on the target species, additional additives might include fish or 
fish oil (e.g. oil from tins of sardines) or fruit flavours such as strawberry essence. For truffle eating species such as bandicoots, truffle 
oil or nut oils soaked into small sections of sponge have proven successful.

Protective bait holders that allow scent to escape but prevent animals from feeding on the lure are usually home made. They have 
been constructed from tea infusers held in a wire cage, cocoa shakers with a bolt to hold the lid on and PVC pipe with end caps 
with holes drilled in them or mesh vent cowls. Sharp edges on bait holders must be avoided.

Bait holders which lead to observable changes in an animal’s behaviour or inadvertently act as feeding stations must be modified 
to prevent this occurring again. We will be using bait holders constructed from PVC pipe with and end cap and vent cowl fitted.

A range of 
protective 
bait holders.
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Other attractants
Besides feed lures, utilising other attractants occurring naturally in the area can be an efficient way to increase camera trap success. 
Examples of such attractants are:

 • Flowering or fruiting plants

 • Water sources (natural or artificial)

 • Carcases

 • Funnelling points (gorges, gateways in fences, log crossings over creeks etc)

 • Tree hollows or nest boxes

DEPLOYMENT
Pre-deployment checks
Before deployment, all cameras should be checked for the following:

• Batteries fully charged

• SD card inserted

• Lens and sensor surfaces clean

• Mounting strap present

• Camera is labelled with DELWP permit number

• Camera labelled with unique ID (it is recommended to keep a list of camera serial numbers and IDs)

Site selection and camera mounting
Correct mounting and aiming of the camera is essential to ensure the greatest chance of detecting and identifying fauna moving 
within the field of view and minimising false triggers.

For general surveys, locate two suitable trees several metres apart. The camera should be mounted so that it is facing approximately 
south. This will minimise false triggers due to sunlight and cut down on glare in daytime photos. If this is difficult to achieve in 
the area being surveyed, posts can be placed in the ground to mount the camera or bait holder or both. The bait holder should 
be located no more than 50 cm above ground height. The camera should be mounted slightly higher and angled down towards 
the bait holder. This will permit detection of fauna investigating the bait station, either larger animals or smaller ground dwelling 
animals. Arboreal fauna may also come down the tree to investigate the bait station.

Example of a camera mounted in the field. The kangaroo and rat would be detected, the wombat and possum are outside the 
detection zones and would not trigger the camera. The grass between the camera and bait holder may cause false triggers.
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There should be a clear field of view between the camera and bait holder. Care should be taken to avoid sites with excessive 
vegetation within the detection zone as this will cause multiple false triggers due to wind movement.  For some sites, some tidying 
up of the surrounding vegetation may be necessary. This should be kept to a minimum to avoid exposing animals to predators, 
people, or weather. Plants or branches should be tied back rather than cut off and the site restored to as natural a condition as 
possible after any camera deployment. The aim should always be to leave no obvious signs of disturbance.

Cameras or other equipment should not be set up so that they block the normal path taken by the animal. Access to burrows, 
escape routes, water points etc must not be restricted by any equipment.

Deploying cameras close to nests that are being constructed, or when there are eggs in a nest, should be avoided. Ravens, in 
particular, have shown the ability to associate camera traps with a nearby meal and this results in increased predation of eggs. The 
nest, nesting hollow, eggs, chicks or other young should never be touched.

Before departing the site, several things need to be checked:

• Camera is turned on and bait holder is filled with an appropriate bait.

• Location has been recorded using GPS. The site can be marked with fluorescent tape if camera visibility is low.

• Any equipment or rubbish picked up.

Upon return from the site, the GPS locations must be backed up onto a PC or other device to ensure that the camera locations are 
not lost.

Arboreal mounting
As well as mounting the camera at ground level or just above, it is possible to mount the camera and bait higher up the tree. This 
provides a greater chance of capturing arboreal species, such as possums, gliders and phascogales. Camera tree mounts and close 
focus lenses are available from the survey organiser.

 

Tree mounts can be held to the tree using a coach screw or tie-down straps. It is safest to turn the camera on before securing the 
tree mount, as doing this afterwards can be awkward depending on the height the camera is mounted. The mount should be held 
firmly with little freedom to move, otherwise there will be numerous  false triggers.

Cameras should be set up so they are facing south, otherwise sun glare will produce many false triggers.
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Retrieval
Cameras are generally deployed for periods up to 3 weeks before retrieval, although this may change depending on the survey 
organisers decisions and the data obtained from initial surveys, which may shorten the time required to obtain photos of most 
species present in an area..

Cameras are relocated using the GPS, unless the camera position can be easily found by memory. Upon return to the site, it is 
always useful to walk in front of the camera so that a check of camera operation on the retrieval date can be made. The state of the 
camera and bait holder should be checked and any observations noted. This may include bite marks on the camera or bait holder 
or other signs of disturbance at the site (diggings etc).

When the camera is removed from the mounting site, it should be turned off to avoid any unnecessary photos being taken. The 
bait holder should be placed in a plastic bag to avoid contaminating other equipment with odours or bait residue. Remove any 
insects that may be on the bait holder before placing in the bag. 

Biosecurity
Where surveys are undertaken in areas known to be infected with Phytophthora cinnamomi (PC), standard boot hygiene 
procedures must be undertaken when leaving the site (brush off adhering mud and spray boots with a solution of 70% methylated 
spirits). 

Baits should be properly disposed off (rubbish or compost) well away from the monitoring site. Do not allow them to be ingested 
by other animals after they have been used.

Cameras and other equipment should be thoroughly checked and cleaned before using on another site. 

Any dry debris should be removed. Bait holders should be cleaned using detergent and water and all traces of bait removed.

What to do if?
Camera damaged or stolen

Report any damage or theft to the survey organiser as soon as possible. They will advise on the appropriate steps to take 
depending on the circumstances.

Dead, injured or distressed animal found on site

Any wildlife in need of rescue or treatment, whether associated with the camera survey or not, should be reported as soon as 
possible. A list of wildlife rescue organisations is given in Appendix II and one of these should be contacted and any instructions 
they give should be followed.

Any animal injury or death that may be associated with the camera survey must be reported to the survey organiser as soon as 
practicable. Dead animals may need to be retrieved and stored for further inspection.

Evidence of animal behavioural issues

Any evidence of changes in animal behaviour caused by the camera survey must be investigated with the survey organiser and 
steps taken to prevent a reoccurrence. Such evidence may include signs of feeding on the bait material, persistent loitering at the 
bait station, evidence of avoidance of the camera site or interactions with predators.
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PHOTO SCREENING AND DATA MANAGEMENT
Camera trap surveys can generate thousands of photos for every camera deployment. A degree of discipline is required to maintain 
order when processing and storing large numbers of files.

Any photo retained, distributed or published should record the truth of what occurred at the time the picture was taken. 
Subsequent manipulation must ensure no radical changes, additions to or subtractions from the picture.

File management
Photos and videos should be transferred from the camera SD card at the earliest possible opportunity. The initial screening can 
occur while the photos are still on the card and any selected files transferred after selection.

The underlying principle of file management for camera surveys is that photos or videos should be easily traceable to a known site 
and date. This is best done using the following procedure:

 • For each camera deployment, create a unique folder name.

 •  Folder name should commence with the numerical format yyyy-mm-dd, being the date the camera was deployed. This will 
ensure directories are listed in chronological sequence and can easily be sorted by date.

 • Folder name should also incorporate the camera ID and an informative location name.

An example directory name would be 2016-10-17 MLN#4 White Elephant Reserve. Directories can be organised under higher level 
directories by location or by year or a combination of both.

Whatever device is used to store the photos and videos should be backed up on a regular basis.

Photo viewing and selection
This photo selection and tagging procedure is based on using Irfan View (http://www.irfanview.com/) which has a simple tagging 
and selection method.

Insert the SD card into the computer and open the first photo with Irfan View. Tag the first photo by pressing the X key. Photo 
viewing and tagging can proceed using one finger on the right arrow key and one on the X key. Tagged photos show an (X) in the 
bottom information bar.

Tagged photos can be untagged by pressing SHIFT+X

Gradually view all the photos and tag those with evidence of fauna present. Do not spend too much time trying to ID fauna during 
the initial selection process. At the end of the photo sequence, tag the last photo taken. 

Press SHIFT+Q to show all tagged files in a thumbnails window.

http://www.irfanview.com/
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Select all of the thumbnails by pressing CTRL+A or using the menu Options > Select all. Then select File > Move selected files. This 
will open a dialog box with a list of possible directories. Select Browse to choose the appropriate directory for the tagged photos. 
Note that this directory must already exist, you cannot create a new directory in this menu option.

When the correct directory has been selected, select Use directory: 1 at the bottom of the window. The photos will then be moved 
to the selected directory. The remaining photos can be deleted from the SD card.

Fauna identification and recording sightings
The pre-screened photos can now be viewed more thoroughly to detect and identify the species observed. You must be 
reasonably confident of an identification before recording the species. When in doubt, refer the image to the study organiser for 
their consideration and possible referral to fauna experts.

Recording of fauna species and the entry of sightings into the Victorian Biodiversity Atlas is covered in another manual. Please 
contact the study organiser for a copy.

Sightings of known threatened species or species unusual for the area should be reported to the DELWP Biodiversity Officer for the 
region. Contact the survey organiser for contact details.

The exact location of pictures of rare or endangered animals should only be disclosed to people or agencies with a valid need for 
that information. When publishing or disseminating pictures, care must be taken that the location is not obvious in the picture or 
embedded in any data files (e.g. EXIF data).

Privacy requirements
If, during the course of camera trapping, pictures of human activity are recorded then these must be deleted from the storage card 
as soon as practicable. Copies must not be kept or transmitted to any third party.

Images of people should only be kept if they show evidence of illegal activity. These must be handed over to the relevant 
authorities as soon as practicable.
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TROUBLESHOOTING
Large number of empty photos
Check the photos in a sequence to see if moving vegetation in the back ground could be causing false triggers. If so, future site 
selection should take account of this. Alternatively, the PIR sensitivity can be lowered.

Check the camera menu settings to ensure that the camera has not been set on time lapse mode, or that the PIR sensitivity is not 
too high.

No sightings
Check the camera menu settings to ensure PIR sensitivity is appropriate.

Ensure that the camera is operating correctly. Set it up in an area and walk in front of it to ensure it is being triggered by movement.

Photos blurred
Check that the lens is clean. Temporary blurring can occur if the lens is covered with raindrops.

Check the EXIF data for the photo (in Irfan View, select Image > Information the click the EXIF info button). Check that the ISO value 
and shutter speed are within an acceptable range. Shutter speed should be less than 1/30 sec to avoid motion blur. If the photo 
was taken near dawn or dusk, the camera may not have selected infra-red mode even though light levels were low.

Was the bait station too close to the camera? Camera traps will usually be in focus at distances greater than 1m.
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FURTHER READING AND LINKS
Permits
Land managed under the National Parks Act

http://www.depi.vic.gov.au/forestry-and-land-use/managing-land/forest-and-parks-legislation/victorias-parks-and-reserves-system/
land-managed-under-the-national-parks-act

Authorisations under the National Parks Act 1975: Application for a Permit to Conduct Research in National Parks 

Authorisations under the Wildlife Act 1975: Application for Wildlife Permit - Research

http://www.depi.vic.gov.au/environment-and-wildlife/forms-for-wildlife-national-parks-and-the-flora-and-fauna-guarantee-act

Wildlife and Small Institutions Animal Ethics Committee

http://agriculture.vic.gov.au/agriculture/animal-health-and-welfare/animals-used-in-research-and-teaching/animal-ethics-
committees/wildlife-and-small-institutions-animal-ethics-committee

Camera trapping manuals and books
A guide for the use of remote cameras for wildlife survey in northern Australia

http://www.nespnorthern.edu.au/wp-content/uploads/2015/10/5.2.4_a_guide_to_use_of_remote_cameras_for_wildlife_surveys_
final_web.pdf

Meek PD, Ballard G and Fleming P (2012). An Introduction to Camera Trapping for Wildlife Surveys in Australia, Invasive Animals 
Cooperative Research Centre.

http://www.feral.org.au/camera-trapping-for-wildlife-surveys/

Fauna information
Survey guidelines for Australia’s threatened mammals

https://www.environment.gov.au/resource/survey-guidelines-australias-threatened-mammals-guidelines-detecting-mammals-
listed

Atlas of Living Australia

http://www.ala.org.au/

Australian Government databases and online resources

http://www.australia.gov.au/information-and-services/environment/biodiversity-plants-and-wildlife

http://www.environment.gov.au/biodiversity/abrs/online-resources/fauna/index.html

Animal welfare and ethics
Wildlife Photographers Australia Code of Conduct http://wildlifephotographersaustralia.org/codeofconduct.html

The Nature Photographers’ Code of Practice, Royal Photographic Society Nature Group 

http://www.rps.org/special-interest-groups/nature/about/the-nature-photographers-code-of-practice

Australian code for the care and use of animals for scientific purposes

https://www.nhmrc.gov.au/guidelines-publications/ea28

http://www.depi.vic.gov.au/forestry-and-land-use/managing-land/forest-and-parks-legislation/victorias-parks-and-reserves-system/land-managed-under-the-national-parks-act 
http://www.depi.vic.gov.au/forestry-and-land-use/managing-land/forest-and-parks-legislation/victorias-parks-and-reserves-system/land-managed-under-the-national-parks-act 
http://www.depi.vic.gov.au/environment-and-wildlife/forms-for-wildlife-national-parks-and-the-flora-and-fauna-guarantee-act 
http://agriculture.vic.gov.au/agriculture/animal-health-and-welfare/animals-used-in-research-and-teaching/animal-ethics-committees/wildlife-and-small-institutions-animal-ethics-committee 
http://agriculture.vic.gov.au/agriculture/animal-health-and-welfare/animals-used-in-research-and-teaching/animal-ethics-committees/wildlife-and-small-institutions-animal-ethics-committee 
http://www.nespnorthern.edu.au/wp-content/uploads/2015/10/5.2.4_a_guide_to_use_of_remote_cameras_for_wildlife_surveys_final_web.pdf 
http://www.nespnorthern.edu.au/wp-content/uploads/2015/10/5.2.4_a_guide_to_use_of_remote_cameras_for_wildlife_surveys_final_web.pdf 
http://www.feral.org.au/camera-trapping-for-wildlife-surveys/ 
https://www.environment.gov.au/resource/survey-guidelines-australias-threatened-mammals-guidelines-detecting-mammals-listed 
https://www.environment.gov.au/resource/survey-guidelines-australias-threatened-mammals-guidelines-detecting-mammals-listed 
http://www.ala.org.au/ 
http://www.australia.gov.au/information-and-services/environment/biodiversity-plants-and-wildlife 
http://www.environment.gov.au/biodiversity/abrs/online-resources/fauna/index.html 
http://wildlifephotographersaustralia.org/codeofconduct.html
http://www.rps.org/special-interest-groups/nature/about/the-nature-photographers-code-of-practice 
https://www.nhmrc.gov.au/guidelines-publications/ea28
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APPENDIX II – WILDLIFE RESCUE 
ORGANISATIONS
This information is taken from the DELWP website on wildlife rehabilitation

http://delwp.vic.gov.au/environment-and-wildlife/wildlife/wildlife-rehabilitation

DO NOT HANDLE WILDLIFE UNLESS ADVISED TO DO SO
Treat wildlife with caution, especially when they are distressed or injured, as they can be 
dangerous. Wherever possible, wait for an experienced/qualified person to arrive. Wildlife can 
bite, scratch, kick and carry diseases. The following species are dangerous and should only be 
handled by experienced/qualified persons. 

Snakes:  Most snakes in Victoria are venomous and should only be handled by experienced 
snake handlers.

Birds of prey, large kangaroos and goannas (monitors): These species can be dangerous 
and should only be handled by wildlife rehabilitators

Flying-foxes (bats): Can carry diseases, such as the Australian Bat Lyssavirus, which can 
be transmitted to people, and should only be handled by appropriately vaccinated wildlife 
rehabilitators. Avoid handling injured or entangled flying-foxes. If bitten or scratched, 
immediately wash the wound thoroughly with soap and water and contact a doctor.

Emergency Wildlife and Rescue – BADGAR  1300 223 427

Wildlife Victoria  1300 094 535

Wildlife Rescue and Information Network (WRIN)  0419 356 433

Wildlife Rescue Emergency Service (WRES)  0427 301 401

http://delwp.vic.gov.au/environment-and-wildlife/wildlife/wildlife-rehabilitation 

